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This chapter describes the various components of the Merlin for GPRS G201 PC 
Card modem. 

Merlin for GPRS Modem Components
The Merlin for GPRS modem has three general components:
• The antenna,

• The PC Card, and

• The SIM card slot.

Figure 1 shows a top view of the modem and indicates the location of the general 
components.

Figure 1 Modem Components

The PC Card
The PC Card, shown in Figure 1, contains the modem’s circuitry. When this card 
is inserted into your computer’s PC Card slot, the antenna extends outside of the 
slot. To prevent damage, you should always remove the modem from the PC Card 
slot whenever you move your computer.
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The SIM Card Slot
You must insert your SIM card into the SIM card slot, shown in Figure 1, in order for your modem 
to access your GPRS or GSM network account information and connect to the network. See 
“Using the SIM card” on page 2 for more information.

The Antenna
The Merlin for GPRS modem’s antenna can be rotated in many directions to receive the best 
signal reception. Rotate the antenna up and out of the way when you insert the modem into your 
computer’s PC Card slot. Fold the antenna against the back of the modem for storage, as shown 
in Figure 2, once you have removed it from your computer.

Figure 2 Storing the Antenna

Using the SIM Card
In order to use your Merlin for GPRS modem, you must have a GSM/GPRS network account. Your 
network account information is stored on the SIM card, shown in Figure 3.

Figure 3 SIM Card

The SIM (Subscriber Identity Module) card contains a small amount of memory and a processor 
to assist in the management of your account information.

SIM Card 
Contacts

Orientation
Notch
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 Getting Started 3
The SIM card uses contact points to connect with the modem. You must take care not to damage 
the contact point.

The orientation notch is used as a reference for properly inserting the SIM card into the modem. 
Inserting the SIM card incorrectly will prevent the modem from communicating with the network.

Inserting the SIM Card
The SIM card is inserted into the SIM Card Slot, as shown in Figure 4.

Figure 4 Inserting the SIM Card

Verify that SIM card contacts face downward and that the orientation notch is located at the 
outside edge of the modem.

Removing the SIM Card
Remove the SIM card by sliding the SIM Card Eject Button, located on the top of the modem, 
shown in Figure 5.

Figure 5 Removing the SIM Card
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Inserting the Modem into Your Computer
To insert your Merlin for GPRS modem, locate the PC Card slot on your computer, rotate the 
antenna into the upright position, verify that the modem is face up, and insert the front end of the 
modem into the PC Card slot.

Removing the Modem from Your Computer

To remove the Merlin for GPRS modem, first click the PC Card tray icon  (located in the 
bottom-right corner of your desktop) to stop the modem. A message will appear instructing you 
that it is now safe to remove your modem. Press the PC Card slot eject button and remove the 
modem from the PC Card slot.

Note: The PC Card slots must be able to accept Type II PC Cards.

Merlin
PC Card modemPCMCIA card

slot with SIM installed

PC
Manual Revision 1.0
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Before you can use your Merlin for GPRS PC Card modem, you must first install 
the GPRS Modem Manager software. This chapter will guide you through the 
installation procedure.

The installation procedure that you will use depends on the operating system of 
your PC.

To install the GPRS Modem Manager software on a Windows 98, 2000, ME, or 
XP platform, please see the installation procedure below.

To install the GPRS Modem Manager software on a Windows NT 4.0 platform, 
please see page 9.

Installing the GPRS Modem Manager 
Software on Windows 98, 2000, ME, or 
XP
Before you begin the installation procedure, verify you have the following items.

• Merlin for GPRS PC Card modem,
• Type II PC Card slot,

• Installation CD for Merlin GPRS PC Card modem,

• Internet browser software (for example Microsoft Internet Explorer® 5),
• GPRS/GSM account with a service provider.

Note: Do not insert the modem into your computer until prompted by the Setup 
program.
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To install the GPRS Modem Manager software:

1. Insert the Installation CD into the CD drive of your computer. The Installation program will 
automatically launch, and display the Welcome window, shown in Figure 6

.

Figure 6 Welcome window

2. Read the contents of the window and click Next to continue. The License Agreement 
window will be displayed, shown in Figure 7.

Figure 7 License Agreement window
Manual Revision 1.0 P/N 90023333
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3. Read the License Agreement and click I have read and agree to the above terms if you 
are satisfied with the conditions of the agreement. 

4. Click Next to continue. The Destination Folder window will be displayed, as shown in 
Figure 8.

Figure 8 Destination Folder

5. Select the desired folder for the Modem Manager software installation. Most users will select 
the default directory. If you would like a shortcut to the GPRS Modem Manager placed on 
your desktop, select the Place a shortcut on the desktop check box.
Manual Revision 1.0 P/N 90023333
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6. Click Next to continue. The Installing window will be displayed, shown in Figure 9. The 
Modem Manager program will be installed in the folder indicated previously.

Figure 9 Installing window

Once the Modem Manager has been successfully installed, the Installation Complete 
window will be displayed, shown in Figure 10.

Figure 10 Installation Complete window
Manual Revision 1.0 P/N 90023333
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7. Click Finish to exit the installation program. 

8. Insert the Merlin for GPRS modem into your computer’s PC Card slot. Windows will display 
the Found New Hardware window, shown in Figure 11.

Figure 11 Found New Hardware window

Windows will install the necessary drivers in order for your Merlin for GPRS modem to connect 
to the network.

You can now use the Modem Manager software to configure and control your modem. To access 
the Modem Manager software, double-click the Modem Manager desktop icon (if you requested 
the shortcut be placed on your desktop), or select Start !!!! Programs !!!! Novatel Wireless !!!!
Merlin GPRS !!!! GPRS Modem Manager.

Please see Using Connection Profiles on page 25 for further instructions.

Installing the GPRS Modem Manager Software 
on Windows NT 4.0
Before you begin the installation procedure, verify you have the following items.

• Windows NT 4.0 (service pack 6). See www.windowsupdates.microsoft.com for updates.
• Merlin for GPRS PC Card modem,

• Type II PC Card slot,

• Internet browser software (for example Microsoft Internet Explorer® 5),

• GPRS/GSM account with a service provider.

Note:
Depending on the operating system you are using, you may be prompted to restart your com-
puter in order to complete the installation procedure. Click Yes to restart your computer 
immediately. Once your computer has restarted, continue with Step 8.

Note:

Microsoft® Windows NT® 4.0 does not support plug and play. Before you can operate the 
Merlin for GPRS modem, you must first install a third-party PC card enabling application (e.g. 
TouchStone® CardWare™: http://www.touchstone-sc.com/products/products.htm)
You need to install the PC card-enabling software before you insert the PC Card modem into 
your Type II PC card slot. Follow the manufacturer’s instructions for installing the PC card 
enabling software. The installation procedure below uses TouchStone® CardWare™ as an 
example.
Manual Revision 1.0 P/N 90023333
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Before you begin installing the Modem Manager application, you must first install the Merlin for 
GPRS modem drivers. You will be required to complete the following actions in order to 
successfully install the Merlin for GPRS modem drivers:

• Verify the modem’s COM port,

• Install the modem drivers, and
• Configure the modem’s properties and dial-up networking.

Once you have completed the actions listed above, launch the Merlin for GPRS Modem Manager 
Setup procedure, located on the Installation CD. After you have successfully installed the Merlin 
for GPRS modem drivers and Modem Manager software, you will be able to use your Merlin for 
GPRS modem with your Internet applications.

Verifying the PC Card COM port
To verify the PC card COM port:

1. Insert the Merlin for GPRS modem into your computer’s Type II PC Card slot.

2. Start your computer and log on to Windows NT as “administrator”.

3. Select Start !!!! Settings !!!! Control Panel. The Control Panel will be displayed, shown in 
Figure 12.

Figure 12 Control Panel window
Manual Revision 1.0 P/N 90023333
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4. Double-click the PC Card (PCMCIA) icon. The PC Card (PCMCIA) Devices window will be 
displayed, shown in Figure 13.

Figure 13 PC Card (PCMCIA) Devices window

5. Select Novatel Wireless Merlin GPRS Modem and click Properties. The Modem 
Properties window will be displayed, shown in Figure 14.

Figure 14 Modem Properties window

6. Record the COM port to which the Merlin GPRS modem is mapped. In this example the modem 
is mapped to Com 3.
Manual Revision 1.0 P/N 90023333
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7. Click OK. The PC Card (PCMCIA) Devices window will be displayed, shown in Figure 15.

Figure 15 PC Card (PCMCIA) Devices window

8. Click OK to close the window. You will be returned to the Control Panel.

Installing the Modem Drivers
To install the Merlin for GPRS modem drivers:

1. Double-click the Modems icon from the Control Panel, shown in Figure 16. 

Figure 16 Modems icon
Manual Revision 1.0 P/N 90023333
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The Install New Modem window is displayed, shown in Figure 17.

Figure 17 Install New Modem window

2. Select the “Don’t detect my modem; I will select it from a list” check box and click Next 
to continue. The following Install New Modem window will be displayed, shown in Figure 18.

Figure 18 Install New Modem window (2)
Manual Revision 1.0 P/N 90023333
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3. Click the Have Disk button. The Install From Disk dialog box will be displayed, shown in 
Figure 19.

Figure 19 Install From Disk dialog box

4. Insert the Novatel GPRS Modem PC Card Installation CD into your computer, and explore 
your CD drive (in this example, D:/).

5. Select Drivers/WinNT4. From the WinNT4 folder, select NwtGprs.inf and click OK to 
continue. You will be returned to the Install New Modem shown in Figure 20.

Figure 20 Install New Modem window (2)

Note: The Novatel Wireless Setup program may automatically launch during Step 4. You must quit 
the Setup program in order to explore the CD.
Manual Revision 1.0 P/N 90023333
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6. Click Next to continue. The Install New Modem window will be displayed, shown in Figure 
21.

Figure 21 Install New Modem window (3)

7. Ensure that the Selected ports radio button is selected and the correct COM port, which 
you recorded earlier, is highlighted.

8. Click Next to continue. The Install New Modem window will be displayed, shown in Figure 
22.

Figure 22 Install New Modem Complete window
Manual Revision 1.0 P/N 90023333
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9. Click Finish. The Modems Properties window is displayed, shown in Figure 23.

Figure 23 Modems Properties window

Properties

Merlin
ModemModem

list
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Configuring the Modem’s Properties and Dial-up 
Networking on Windows NT 4.0
To configure the modem’s properties and dial-up networking:

1. Select Novatel Wireless Merlin GPRS Modem from the Modem Properties window 
modem list and click Properties, shown in Figure 23. The Novatel Wireless Merlin GPRS 
Modem Properties window will be displayed, shown in Figure 24.

Figure 24 Modem Properties window

2. Ensure that the Maximum speed is set to 57600.
Manual Revision 1.0 P/N 90023333
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3. Select the Connection tab, shown in Figure 25.

Figure 25 Connection Tab

4. Ensure that Connection preferences are set to 8, None and 1. 

5. Click the Advanced button. The Advanced Connection Settings window will be displayed, 
shown in Figure 26.

Figure 26 Advanced Connection Settings window

Advanced

Close
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6. In the Extra settings field, enter the command string as shown in Figure 26, replacing 
“MYGPRS.COM” with the correct APN (Access Point Name), obtained from your service 
provider.

7. Click OK. You will be returned to the Novatel Wireless Merlin GPRS Modem Properties 
window.

8. Click Close . The Modem Setup message box will be displayed, shown in Figure 27, 
inquiring if you wish to configure Dial-up Networking now.

Figure 27 Modem Setup Message

9. Click Yes to configure Dial-up Networking. The Remote Access Setup window will be 
displayed, shown in Figure 28.

Figure 28 Remote Access Setup

Note:
If the Modem Setup message box is not displayed your computer may not have Remote 
Access Service or Networking installed. Please see your Windows NT User’s Manual for 
instructions on installing these two components.
Manual Revision 1.0 P/N 90023333
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10. Click Add. The Add RAS Device dialog box will be displayed, shown in Figure 29.

Figure 29 Add RAS Device dialog box

11. Select COMx - Novatel Wireless Merlin GPRS from the RAS Capable Devices drop down 
list and click OK (the value of x depends on the COM port selected). The Port, Device 
Name, and Type will be listed in the Remote Access Setup window, shown in Figure 30.

Figure 30 Remote Access Setup window

12. Click Continue to bind the device to the COM port. The Network Settings Change 
message box will be displayed, shown in Figure 31.

Figure 31 Network Settings Change message

13. Click Yes to restart your computer.
Manual Revision 1.0 P/N 90023333
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Installing Modem Manager Software on Windows NT 4.0
To install the GPRS Modem Manager software:

1. Insert the Installation CD into the CD drive of your computer. The Installation program will 
automatically launch and display the Welcome window, shown in Figure 32.

Figure 32 Welcome window

2. Read the contents of the window and click Next to continue. The License Agreement 
window will be displayed, shown in Figure 33.

Figure 33 License Agreement window
Manual Revision 1.0 P/N 90023333
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3. Read the License Agreement and click I have read and agree to the above terms if you 
are satisfied with the conditions of the agreement. 

4. Click Next to continue. The Destination Folder window will be displayed, as shown in 
Figure 34.

Figure 34 Destination Folder

5. Select the desired folder for the Modem Manager software installation. Most users will select 
the default directory. If you would like a shortcut to the GPRS Modem Manager placed on 
your desktop, select the Place a shortcut on the desktop check box.
Manual Revision 1.0 P/N 90023333



 Installing the Modem Software 23
6. Click Next to continue. The Installing window will be displayed, shown in Figure 35. The 
Modem Manager program will be installed in the folder indicated previously

.

Figure 35 Installing window

Once the Modem Manager has been successfully installed, the Installation Complete 
window will be displayed, shown in Figure 36.

Figure 36 Installation Complete window
Manual Revision 1.0 P/N 90023333
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7. Click Finish to exit the installation program. 

8. Insert the Merlin for GPRS modem into your computer’s PC Card slot. Windows will display 
the Found New Hardware window, shown in Figure 37.

Figure 37 Found New Hardware window

Windows will install the necessary drivers in order for your Merlin for GPRS modem to connect 
to the network. 

Use the Modem Manager software to configure and control your modem. To access the Modem 
Manager software, double-click the Modem Manager desktop icon (if you requested the shortcut 
be placed on your desktop), or select Start !!!!Programs !!!!Novatel Wireless !!!!Merlin GPRS
!!!!GPRS Modem Manager.

Please see Using Connection Profiles on page 25 for further instructions.

Note:
Depending on the operating system you are using, you may be prompted to restart your com-
puter in order to complete the installation procedure. Click Yes to restart your computer 
immediately. Once your computer has restarted, continue with Step 8.
Manual Revision 1.0 P/N 90023333
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The Modem Manager software you have installed with your Merlin for GPRS PC 
Card modem may be preconfigured with one or more Connection Profiles. 

A Connection Profile consists of connection information stored by the Modem 
Manager software. It contains all of the necessary data to identify your modem to 
your service provider in order to access your GSM or GPRS network account.

Depending on your service provider’s requirements, your modem will use a single 
pre-defined connection profile or multiple pre-defined connection profiles. You 
can also create your own (user-defined) connection profiles using the Add 
Connection Wizard.

Using a Single Pre-Defined Connection 
Profile
If your service provider requires you to use a single pre-defined connection 
profile, once you have successfully installed the Modem Manager software, no 
further modem configuration will be necessary. When launched, the Modem 
Manager will automatically use the single pre-defined connection profile 
(previously installed by your service provider) to connect to the GSM or GPRS 
network.

Using Multiple Pre-Defined Connection 
Profiles
If your service provider has installed a number of pre-defined connection profiles, 
once you have successfully installed the Modem Manager software, you must 
select the connection profile you wish to use from the Connection Selection 
window. See Figure 38.
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To select a connection profile:

1. Launch the Modem Manager and select a connection profile (as instructed by your service 
provider) from the Connection Selection window.

Figure 38 Connection Selection window

2. Click Connect to connect to the GPRS or GSM network.

Creating a User-defined Connection Profile
You can create your own (user-defined) connection profile to connect to the GPRS or GSM 
network (you must obtain the connection information from you service provider). The Add 
Connection Wizard will assist you in creating either a GPRS or GSM connection profile.

To create user-defined connection profile:

1. Launch the Modem Manager by double-clicking on the GPRS Modem Manager desktop icon 
(If the icon is on your desktop), shown in Figure 39.

Figure 39 Modem Manager Icon

You can also launch the Modem Manager by selecting Start -> Programs -> Novatel 
Wireless -> Merlin GPRS -> GPRS Modem Manager.
Manual Revision 1.0 P/N 90023333
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If you have not created a connection profile previously, or the Modem Manager did not come 
with a pre-defined connection profile, the Setup dialog box will appear, shown in Figure 40.

Figure 40 Setup dialog box

2. Click Create Connection Now to launch the Add Connection Wizard. The Add 
Connection Wizard will guide you through creating a connection profile. When you create 
a connection profile, you will choose to create either a GSM or GPRS connection profile. 
Your service provider will tell you which connection type to choose.

(If you choose Create Connection Later, you will be able to access the Add Connection 
Wizard later from the Connection Manager window.)

If your service provider uses a GPRS network, see Creating a GPRS Connection Profile on 
page 27 for further instructions. If your service provider uses a GSM network, see Creating a 
GSM Connection Profile on page 30.

Creating a GPRS Connection Profile
To create a GPRS connection profile:

1. Select Connection Manager from the Tools menu. The Connection Manager window will 
be displayed, shown in Figure 41.

Figure 41 Connection Manager window

Note:
If you chose Create Connection Now from the Setup window, shown in Figure 40, the Add 
Connection Wizard will automatically launch (you will not see the Connection Manager win-
dow).
Manual Revision 1.0 P/N 90023333
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2. Click Add. The Add Connection Wizard will launch and display the Connection Name 
dialog box, shown in Figure 42.

Figure 42 Connection Name dialog box

3. Type the name of your connection profile in the Connection name text field (any name of 
your choice).

4. Click Next to continue. The Connection Type dialog box will be displayed, shown in Figure 
43.

Figure 43 Connection Type dialog box

5. Select the GPRS radio button (as instructed by your service provider).

6. Click Next to continue. The GPRS Protocol dialog box will be displayed, shown in Figure 
44.

Figure 44 GPRS Protocol dialog box
Manual Revision 1.0 P/N 90023333
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7. Type the APN (Access Point Name), obtained from your service provider, into the APN field.

8. Enter the Primary and Secondary DNS addresses (obtained from your service provider) 
into the appropriate fields, or if you have been instructed by your service provider to have 
the Modem Manager automatically search for the DNS addresses, select the Obtain DNS 
server addresses automatically check box.

9. Click Next to continue. The Enter User Information dialog box will be displayed, shown in 
Figure 45.

Figure 45 Enter User Information dialog box

10. If your service provider requires you to enter a user name and password, select A user 
name and password are required by my carrier, and enter the User name and Password 
(obtained from your service provider) into the appropriate fields.

If your service provider does not require a user name or password, leave all fields empty.

11. Click Next to continue. The Default Connection dialog box will be displayed, shown in 
Figure 46.

Figure 46 Default Connection dialog box

12. Select Yes to make the new network connection profile your default connection, or No to 
keep the existing default connection profile settings.

13. Click Finish to add the new network connection profile to the Connection Profile list pane.
Manual Revision 1.0 P/N 90023333
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Creating a GSM Connection Profile
To create a GSM connection profile:

1. Select Connection Manager from the Tools menu. The Connection Manager window will 
be displayed, shown in Figure 47.

Figure 47 Connection Manager window

2. Click Add. The Add Connection Wizard will launch and display the Connection Name 
dialog box, shown in Figure 48.

Figure 48 Connection Name dialog box

3. Type the name of your connection profile in the Connection Name text field (any name of 
your choice). 

Note:
If you chose Create Connection Now from the Setup window, shown in Figure 40, the Add 
Connection Wizard will automatically launch (you will not see the Connection Manager win-
dow).
Manual Revision 1.0 P/N 90023333
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4. Click Next to continue. The Connection Type dialog box will be displayed, shown in Figure 
49.

Figure 49 Connection Type dialog box

5. Select GSM-Data radio button (as indicated by your service provider).

6. Click Next to continue. The GSM Protocol dialog box will be displayed, as shown in Figure 
50.

Figure 50 GSM Protocol dialog box

7. Type your User Name, Password, and Phone Number (these items are obtained from your 
service provider) into the appropriate fields.

8. Click Next to continue. The Default Connection dialog box will be displayed, shown in 
Figure 51.

Figure 51 Default Connection dialog box

9. Select Yes to make the new network connection profile your default connection, or No to 
leave the existing default connection profile settings, and click Finish to add the new 
connection profile to the Connection Profile list pane.
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32  Using Connection Profiles
Manual Revision 1.0 P/N 90023333



Using the Modem 
Manager
MM MM
ee ee rr rr

ll ll ii ii nn nn
        GG GG

PP PPRR RR
SS SS     

TT TT rr rr
ii ii -- -- bb bb

aa aann nn
dd dd
The GPRS Modem Manager software allows you to configure and control your 
Merlin for GPRS modem. The following sections will instruct you on using the 
Modem Manager and its various features.

Launching the Modem Manager
To launch the Modem Manager:

10. Verify that the SIM card is properly inserted into your Merlin for GPRS G201 
modem, and insert the modem into your computer’s PC Card slot. See 
Getting Started for further instruction on this procedure.

11. Launch the Modem Manager application by double-clicking the Modem 
Manager icon (if you requested an icon be placed on your desktop, or by 
selecting Start ->  Programs -> Novatel Wireless -> Merlin GPRS -> GPRS 
Modem Manager.

The Modem Manager main window will open, shown in Figure 52, and 
attempt to initalize and connect with the Merlin for GPRS modem through the 
PC Card port. 

Figure 52 Modem Manager window

If your service provider requires you to enter a PIN (Personal Identification 
Number) before the Modem Manager can register and connect to your 
modem, see Entering Your Account PIN on page 34 for more information.
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Once the Modem Manager has successfully connected to the Merlin for GPRS modem, the 
application will attempt to register the modem to the GPRS/GSM network as indicated by 
your default connection profile.

When the modem has successfully registered to the network, the Current Status field will 
display Ready to connect, home network and the Carrier field will display the name of 
your service provider, shown in Figure 53.

Figure 53 Successful Registration

Entering Your Account PIN
If your service provider requires you to enter a PIN (Personal Identification Number) before you 
can use your network account, the Modem Manager will display the Enter PIN dialog box, shown 
in Figure 54, before registering to the network.

Figure 54 Enter PIN dialog box

Note:
If the Modem Manager is unable to connect to your Merlin for GPRS modem, verify that both 
the SIM card and your modem are properly installed. The Current Status field will indicate if 
the SIM card or modem are missing.
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Type your PIN, obtained from your service provider, into the text field and click OK. If you would 
like the Modem Manager software to remember your PIN, select the Remember PIN check box. 
See Figure 55.

Figure 55  Remember PIN check box

Once you have selected the Remember PIN check box, you will not be required to enter your PIN 
when you launch the Modem Manager application.

If you have entered an incorrect PIN, an error message will be displayed. Click OK to close the 
error message, verify you have the correct PIN and carefully reenter it in the Enter PIN dialog 
box. 

If you enter a PIN three times incorrectly, your SIM card will be blocked, as shown in Figure 56, 
and you must obtain a PUK (PIN Unblocking Key) from your service provider. See Entering a 
PUK on page 36 for more information.

Figure 56 Error message

If you have forgotten your PIN, click Forgot PIN... from the Enter PIN dialog box, and contact 
your service provider to obtain a PUK (PIN Unblocking Key). See Entering a PUK on page 36 
for more information.
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Entering a PUK
If you have forgotten your PIN or have entered an incorrect PIN three or more times, you are 
required to enter a PUK (PIN Unblocking Key), in order to unblock your SIM card. See Figure 57.

Figure 57 Enter PUK and PIN dialog box

Your service provider will give you the PUK and a new PIN. Carefully enter these values into their 
respective fields, and click OK to save the values. Once the values have been accepted, the SIM 
card will no longer be blocked and the PIN will be changed. The Modem Manager will now be 
able to access your network account information.

Note: If you enter a PUK incorrectly three times, the SIM card will again be blocked. You must con-
tact your service provider to obtain a new PUK and PIN.
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Enabling or Disabling the PIN
You may enable or disable your PIN through the SIM tab (select Properties from the Modem 
menu), shown in Figure 58.

Figure 58 SIM tab

The Enable/Disable button, located at the bottom of the tab, will toggle between Disable PIN or 
Enable PIN, depending on your current PIN settings.

In order to change the setting, you will be required to enter your PIN in the Enter PIN dialog box, 
shown in Figure 59.

Figure 59 Enter PIN dialog box

Once you have entered the correct PIN, the desired PIN setting (either enabled or disabled) will 
be saved.

Note:
If you select Enable PIN, the Enter PIN dialog box will be reactivated, regardless of whether 
you had previously directed the Modem Manager to remember your PIN (selecting the 
Remember PIN check box).
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Changing Your PIN
To change your PIN, select Properties from the Modem menu. Click the SIM tab, shown in Figure 
60.

Figure 60 SIM tab

Click Change PIN. The Change PIN dialog box will be displayed, shown in Figure 61.

Figure 61 Change PIN dialog box

Enter the current PIN into the Current PIN field, enter the new PIN into the New PIN field, and 
enter the new PIN again into the Confirm New PIN field. Click OK. The new PIN will be saved 
and a confirmation window will be displayed indicating the change has been accepted.
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Connecting to the Network

To connect to the network, open the Modem Manager main window, and click Connect. The 
modem will then attempt to register and connect to the network using the information provided in 
the default connection profile. See Figure 62. 

Figure 62 Connect button

Once the Modem Manager has successfully registered and connected to the network, the 
Current Status field will display the message Connected.

If you have not specified a connection profile as your default setting, the Modem Manager 
requires you to select the desired profile from the Connection Selection window, shown in 
Figure 63.

Figure 63 Connection Selection window

For more information on connecting to the network using an alternate connection profile, see 
Using Multiple Connection Profiles on page 40.

Note:
The Modem Manager must have access to a connection profile in order to connect to the 
network. If you have not been provided with a pre-defined connection profile, or have not 
created one previously, see Creating a New Connection Profile on page 42 for more infor-
mation.
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You may also direct your modem to automatically connect to the network when the Modem 
Manager is launched by selecting Options from the Tools menu, and selecting the 
Automatically connect when GPRS Modem Manager is launched check box (the option is 
selected by default), shown in Figure 64.

Figure 64 Autoconnect check box

Using Multiple Connection Profiles
To use an alternate connection profile (without changing your default settings) to connect to the 
network, select Connect from the Modem menu. The Connection Selection window will appear, 
shown in Figure 65.

Figure 65 Connection Selection window

Highlight the desired profile and click Connect. The Modem Manager will attempt to use the 
specified connection profile to connect to the network.
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Disconnecting from the Network
To disconnect from the network, close all Internet applications, such as e-mail and web browsers, 
and from the Modem Manager main window, click Disconnect. See Figure 66.

Figure 66 Disconnect button

Alternately, you can select Disconnect from the Modem menu, shown in Figure 67.

Figure 67 Disconnect command

To disconnect from the network, and close the Modem Manager application, click the , located 
in the top-right corner of the Modem Manager main window.
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Quitting the Modem Manager
To quit the Modem Manager application, click the , located in the top-right corner of the 
Modem Manager main window.

Alternately, you can select Exit from the Modem menu, as shown in Figure 68.

Figure 68 Exit command

The modem will terminate its network connection, and the Modem Manager will shut down.

Creating a New Connection Profile
If you have arranged to have more than one network account, you need to create a new 
connection profile. Your service provider will provide you with all of the necessary information 
such as, APN (Access Point Name), DNS addresses, Connection type, and a user name and 
password, if necessary. Once you have obtained the necessary information, you can begin 
creating a new connection profile. 

If your service provider uses a GPRS network, please see Creating a GPRS Connection Profile 
on page 27 for further instructions. If your service provider uses a GSM network, please see 
Creating a GSM Connection Profile on page 30.
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Editing a Connection Profile

 To edit a connection profile:

1. Select Connection Manager from the Tools menu. The Connection Manager window will 
be displayed, shown in Figure 69.

Figure 69 Connection Manager window

2. Highlight the connection profile you wish to edit from the Connection Profile list pane.

3. Click Properties. The GPRS or GSM Properties window will be displayed, depending on 
the network type of the connection profile.

4. Move to the desired fields and edit the values (use the tabs in the GPRS Properties window 
to navigate to the desired fields).

5. Click OK to save the changes and close the Properties window.

Note:
Do not change your connection profile properties unless requested to do so by your service 
provider. Changing your network information without consulting your service provider may 
disable your modem’s ability to register and connect with the network.

GPRS Properties Window

GSM-Data Properties Window
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Deleting a Connection Profile

To delete a connection profile:

1. Select Connection Manager from the Tools menu. The Connection Manager window will 
be displayed, shown in Figure 70.

Figure 70 Connection Manager window

2. Highlight the desired profile from the Connection Profile list pane.

3. Click Delete. The Delete Connection dialog box will appear, shown in Figure 71.

Figure 71 Delete Connection dialog box

4. Click Yes to delete the connection profile. The specified connection profile will be removed 
form the Connection Profile list pane.

Note:
When you delete a connection profile, all network account information is erased. Your 
modem will be unable to connect to the specified network without access to this information. 
Delete a connection profile only if the specified network account is no longer valid, or if the 
information contained in the connection profile is incorrect.
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Setting a Connection Profile as Default
The Modem Manager will automatically use the information contained in the default connection 
profile when connecting to the network. 

To change the current default setting:

1. Select Connection Manager from the Tools menu. The Connection Manager window will 
be displayed, shown in Figure 72.

Figure 72 Connection Manager window

2. Highlight the desired connection profile from the Connection Profile list pane.

3. Click Set as Default.

The specified connection profile will now be used as your default setting.

Viewing a Connection Profile’s Properties
To view a connection profile’s properties:

1. Select Connection Manager from the Tools menu. The Connection Manager window will 
be displayed, shown in Figure 73.

Figure 73 Connection Manager window

2. Highlight the desired connection profile and click Properties. The GPRS or GSM Properties 
window will be displayed (depending on network type of the connection profile).
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Using the Automatic Network Search Feature
An automatic network search directs the modem to automatically search for a valid network to 
connect to when roaming.

To use this feature:

1. Select Properties from the Modem menu.

2. Click the Roaming tab. The Roaming window will be displayed, shown in Figure 74.

Figure 74 Roaming window

3. Select the Automatic network selection radio button (see the figure above).

4. Click OK to accept the new setting and close the window.
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Using the Manual Network Search Feature
A manual network search will allow you to specify which network your modem connects to when 
roaming.

To use this feature:

1. Select Properties from the Modem menu.

2. Click the Roaming tab. The Roaming window will be displayed shown in Figure 75.

Figure 75 Roaming window

3. Select the Manual network selection radio button.

4. Click Search. The modem will scan for all available networks in the area and list them in the 
drop-down list box, located at the bottom of the Roaming window.

5. Select the desired network from the drop-down list box, and click OK to save the settings.

The modem will now connect with the specified network when directed.
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Viewing the Network Connection History
The modem’s connection history can be useful for diagnosing problems you may be experiencing 
with your modem or network connection.

To view the modem’s network connection history, select Detailed Status Report from the Tools 
menu, and click on the History tab. See Figure 76.

Figure 76 History tab

Keeping the Modem Manager Always Visible
To keep the Modem Manager always visible, select Always on Top from the Window menu, as 
shown in Figure 77.

Figure 77 Always on Top command

Once this command is selected (indicated by a black check mark), the Modem Manager window 
will remain on top of all other windows.

Note:
Click Always on Top a second time to disable this command. The black check mark, located 
next to the menu command, will disappear and the Modem Manager window will no longer 
remain on top of all other active windows.
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Hiding the Modem Manager Window
To hide the Modem Manager window, select Hide Window from the Window menu. See Figure 
78.

Figure 78 Hide Window command

The Modem Manager window will be minimized to the system tray icon .

Collapsing or Expanding the Modem Manager
The Collapse/Expand button, highlighted below, allows you to shrink the Modem Manager 
window, or expand the window to its full view.

Figure 79 represents the expanded view of the Modem Manager main window. Click the 
Collapse/Expand button to shrink the Modem Manager window.

Figure 79 Expanded View
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The collapsed view of the Modem Manager window is displayed in Figure 80. Click the Collapse/
Expand button a second time to expand the Modem Manager to its full view.

Figure 80 Collapsed View

Viewing New Text (SMS) Messages
If your modem is configured to support text (SMS) messaging, any new text messages you have 
received will be visible from the Modem Manager main window, shown in Figure 81, or from the 
Detailed Status Report window. 

Figure 81 Text Messages field

In order to view your message, you must shut down the Modem Manager application, and open 
your third-party, SMS client. 
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Accessing the Modem Manager Online Help
To access the Modem Manager online help, select GPRS Modem Manager Help from the Help 
menu, as shown in Figure 82. 

Figure 82 Modem Manager Help command

Alternately, you can access context sensitive help by striking the F1 key while in the Modem 
Manager application.

Accessing Novatel Wireless Web Support
To access Novatel Wireless web support, select www.novatelwireless.com from the Help menu, 
as shown in Figure 83.

Figure 83 Novatel Wireless Web Support command
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Modem Manager Main Window

The Modem Manager main window has both an Expanded and Collapsed view.

The Modem Manager expanded view, shown in Figure 84 contains the following 
items:

Figure 84 . Expanded View

Current Status Bar This bar displays the current status of the modem and the 
network connection. 

Connect/Disconnect 
Button

This button directs the modem to connect to, or disconnect 
from the network.

Default Connection 
Field

This field displays the name of the connection profile you 
have designated as the default connection setting. 

Available Service 
Field

This field displays the type of network you are currently 
using. 

Carrier Field This field displays the name of the carrier currently provid-
ing your service. 

Signal Strength Field This field displays the modem's signal strength as a per-
centage of the total available signal strength range. The 
values of this range lie between -51 dBm and -113 dBm.

Text Messages This field displays the number of new text messages you 
have received. This field will only be visible if your modem 
is configured to support text (SMS) messaging.
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The Modem Manager collapsed view, shown in Figure 85, contains the following items:

Figure 85 Collapsed View

System Tray Icons
When you launch the Modem Manager application, a system tray icon will appear in the bottom-
right corner of your desktop. The tray icon provides easy access to the Modem Manager main 
window and the modem's connection status.

The following icons indicate the modem's connection status:

 - If this icon is visible, the modem is currently connected to the network. 

 - If this icon is visible, the modem is not connected to the network.

If the Modem Manager window is not visible, double-click on the tray icon to open it.

Alternately, you can control the operation of the Modem Manager by right-clicking on the tray 
icon, and selecting an action from the pop-up menu, shown in Figure 86.

Figure 86 Pop-Up menu

Current Status Bar This bar displays the current status of the modem and the 
network connection. The Current Status bar is located to 
the left of the Connect button.

Connect/Disconnect 
Button

This button directs the modem to connect to, or disconnect 
from the network.

Signal Strength Status 
Bar

This status bar indicates the modem's signal strength. If 
adequate signal strength is present, a number of the five 
bars will be shaded black. The greater number of bars 
filled, the stronger the modem's signal.
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Connection Manager Window
The Connection Manager window, shown in Figure 87, allows you to create and maintain your 
network connection profiles. 

Network connection profiles contain all of the required information to identify the user to the 
network.

To access this window, select Connection Manager from the Tools menu.

Figure 87 Connection Manager window

Detailed Status Report Window
The Detailed Status Report window contains information that is useful when troubleshooting any 
problems you may be experiencing with your modem or network connection.

To view this window, select Detailed Status Report from the Tools menu. 

The Detailed Status Report window consists of the General and History tabs.

The General tab is displayed by default, and contains current information about your modem and 
the network connection. See Figure 88.

Figure 88 General tab
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The General tab contains the following items:

The History tab, shown in Figure 89, displays the date, time, and current modem and network 
session activities. This tab is useful when attempting to diagnose problems with your modem or 
your network connection.

Figure 89 History tab

Current Status Bar This bar, located at the top of the window, displays the cur-
rent status of the modem and the network connection.

Default Connection 
Field

This field displays the name of the connection profile you 
have designated as the default connection setting.

Available Service Field This field displays the type of network you are currently 
using (GPRS or GSM). 

Carrier Field This field displays the name of the carrier currently provid-
ing your service. The name displayed in this field may 
change, depending on your geographical location and 
your service provider's roaming agreements.

Signal Strength Field This field displays the modem's signal strength in dBm 
(decibals below 1 milliwatt).

Bit Error Rate This field displays the percentage of bits that have been 
received in error compared to the total number of bits 
received. The Bit Error Rate will only be visible once your 
modem has established a network connection.

Text Messages This field displays the number of new text messages you 
have received. This field will only be visible if your modem 
is configured to support text (SMS) messaging. 
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Modem Properties Window
The modem Properties window consists of the General, Roaming, and SIM tabs. To view this 
window, select Properties from the Modem menu.

The General tab, shown in Figure 90, is displayed by default and contains detailed information 
regarding your modem's type and manufacturer. This information is helpful for customer support 
in diagnosing problems you may be experiencing with your modem.

Figure 90 General tab

Click on the Roaming tab, shown in Figure 91, to access and configure your roaming settings.

Figure 91 Roaming tab
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The SIM tab, shown in Figure 92, allows you to view and modify your PIN settings.

Figure 92 SIM tab

About GPRS Modem Manager Window
Select About Modem Manager from the Help menu to see the About GPRS Modem Manager 
window, shown in Figure 93.

Figure 93 About Modem Manager window

This window contains information about the Modem Manager application, including:

• The software version,

• The release date, and
• The copyright information.
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GPRS Connection Profile Properties Window
The GPRS connection profile Properties window allows you to view and edit a specific profile's 
network information.

To access this window, highlight the desired GPRS connection profile and click Properties from 
the Connection Manager window. See Figure 94.

Figure 94 Connection Manager window

The GPRS connection profile Properties window consists of the General, Address, and User 
Info tabs.

The General tab, shown in Figure 95, is displayed by default, and contains the name of the 
connection profile, as well as the APN (Access Point Name).

Figure 95 GPRS Properties General tab

Note:
Do not change your connection profile properties unless requested to do so by your 
service provider. Changing your network information without consulting your service 
provider may disable your modem's ability to register and connect with the network.
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The Address tab, shown in Figure 96, contains the Primary DNS, Secondary DNS, Primary 
WINS, and Secondary WINS fields (obtained from your service provider. 

The Primary and Secondary WINS (Windows Internet Naming Service) fields are not required 
by all service providers. If you were not given any values for these fields, leave them blank.

Figure 96 GPRS Properties Address tab

The User Info tab, shown in Figure 97, contains the connection profile's User name and 
Password fields. Your service provider will inform you if a user name and password are required 
to use their network. If these values are not necessary, leave the fields blank.

Figure 97 GPRS Properties User Info tab

Note:
If you did not enter the DNS Addresses or the User Name and Password (if required by 
your service provider) when you created the connection profile, you may enter the values in 
the GPRS Properties window. Click OK to save the new settings and close the window.
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GSM Connection Profile Properties Window
The GSM connection profile Properties window allows you to view and edit a specific profile's 
network information.

To access this window, highlight the desired GSM connection profile and click Properties from 
the Connection Manager window. See Figure 98.

Figure 98 Connection Manager window

The GSM Properties window will open, shown in Figure 99. This window contains the connection 
profile's Connection name, User name, Password, and Phone number fields (obtained from 
your service provider). Click OK to save any changes you have made and to close the Properties 
window.

Figure 99 GSM-Data Properties window

Note:
Do not change your connection profile properties unless requested to do so by your 
service provider. Changing your network information without consulting your service 
provider may disable your modem's ability to register and connect with their net-
work.
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The Options Window
The Options window contains the Automatically connect when GPRS Modem Manager is 
launched check box. See Figure 100.

Figure 100 Options window

When this check box is selected, the Modem Manager will automatically attempt to register and 
connect to the network specified in your default connection profile. You must clear this check box 
if you wish to use an alternate connection profile without changing your default settings.

To access this feature, select Options from the Tools menu.

The Add Connection Wizard
The Add Connection Wizard will guide you through the process of creating either a GPRS or GSM 
connection profile. Your service provider will indicate what type of network to use, and provide 
any additional mandatory information. 

When creating a GPRS connection profile, you are required to enter the connection profile's 
Connection Name, APN (access point name), and the Primary and Secondary DNS (Domain 
Name Server) Addresses. You must also specify the connection type as GPRS, and define 
whether the connection profile will be used as your default setting.

You may also be required to enter a Primary and Secondary WINS (Windows Internet Naming 
Service), User Name, and a Password. Your service provider will supply you with all the above 
information.

When creating a GSM connection profile, you are required to enter the connection profile's 
Connection Name, User Name, Password, and Phone Number. You must also specify the 
connection type as GSM, and define whether the connection profile will be used as your default 
setting. Your service provider will supply you with all the above information.
Manual Revision 1.0  P/N 90023333 



Technical 
Support
MM MM
ee ee rr rr

ll ll ii ii nn nn
        GG GG

PP PPRR RR
SS SS     

TT TT rr rr
ii ii -- -- bb bb

aa aann nn
dd dd
Technical Support
If you require technical support, please contact the supplier of your SIM card or 
your local GSM/GPRS service provider.

Safety and Regulatory Notices
Unauthorized modifications, attachments or antennas not expressly approved by 
Novatel Wireless can void the user’s authority to operate this equipment and 
violate FCC regualations.
This product is not to be used in any environment where radio frequency 
equipment is prohibited or restricted in its use. This includes aircraft, airports, 
hospitals, and other sensitive electronic areas. To ensure that your modem is 
deactivated you should remove it from your computer under the above conditions.
Under extended operation the Merlin for GPRS modem will generate a noticeable 
amount of heat.   Like all PC Cards, the modem generates heat during normal 
operations and is also heated by the host computer. For this reason it is 
recommended that you allow the modem to cool down after extensive operation 
so that it is cool to the touch when you remove it from your computer.

Do not remove antenna from modem during operation.

REGULATORY NOTICES
Federal Communications Commission Radio Frequency Interference 
Statement
This equipment complies with part 15 of the FCC Rules. Operation is subject to 
the following two conditions: (1) that this device may not cause harmful 
interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation.

FCC guidelines stipulate that the antenna should be more than 2.5 cm from all 
persons when transmitting.

This Novatel Wireless modem has been designed to comply with, but is not 
limited to the following international standards and guidelines regarding radio 
frequency electromagnetic energy exposure to human beings:

• United States Federal Communications Commission, Code of Regulations; 47 
CFR part 2 sub-part J

• International Commission on Non-Ionizing Radiation Protection (ICNIRP) 
1998
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• Ministry of Health (Canada) Safety Code 6. Limits of Human Exposure to Radiofrequency 
Electromagnetic Fields in the Frequency Range from 3 kHz to 300 GHz, 1999

• Australian Communications Authority
 Radiocommunications (Electromagnetic Radiation-Human Exposure) Standard 1999

FCC ID: NBZNRM-MG301

General
This equipment generates, uses, and can radiate radio frequency energy, and, if not properly 
installed and used in accordance with the instructions, may cause harmful interference to radio 
or television reception, or to the proper operation of PDAs and laptop computers. This can be 
determined by turning the equipment on and off. You are encouraged to try to correct the 
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna of the television, radio or cordless telephone.
• Increase the separation between the equipment and the receiver.
• Connect the equipment to an outlet on a circuit different from that to which the receiver is 

connected.

Consult the dealer or an experienced radio/television technician for additional suggestions.
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Access Point Name (APN)

The IP domain name (e.g.; novatelwireless.com) of the network device that 
acts as a gateway by connecting a GPRS wireless radio network to a wired 
local or wide area network.

Active Network Session
An active network session allows you to send and receive data across the 
Internet using point-to-point protocol through your current network 
connection.

AT Commands
AT commands are a modem-specific language type that enables PC 
communications software control the modems directly. The term AT comes 
from the command terminology which always begins with attention, or AT.

dBm
dBm stands for decibels below 1 milliwatt. It is a measurement of a device’s 
signal output power compared against a standard input signal strength of 1 
milliwatt. This number represents a ratio and is expressed as a negative 
number (e.g.; -60dBm). The valid range for your Merlin for GPRS is -113 dBm 
to -51 dBm. Values closer to zero indicate a better reception. The value -51 
dBm indicates a better reception than -113dBm.

Default Network Connection Profile
The default network connection profile is the connection profile, chosen by 
the user, that the Modem Manager will use to connect to the network. The 
default network connection profile can be thought of as the active network 
connection profile.

Domain Name
The name assigned to a computer or group of computers that constitute an IP 
network domain. In general, a domain name is comprised of its local host 
name and its top-level domain. The top-level domain can be made up of 
several names, each separated by a period (.).
An example of a domain name is novaltelwireless.com.

Domain Name System (DNS)
This is a network server used on IP networks, such as the Internet, for 
translating network host names and Universal Resource Locators (URL’s) into 
IP addresses.

Domain Name System (DNS) Address
The IP (internet protocol) address of the Domain Name System (DNS).
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Firmware
Firmware is a program or set of programs that have been set permanently into a computer 
chip. These are low-level programs that directly manipulate or interact with the hardware. 
Firmware is a single program or a combination of programs that have been placed on a 
PROM, EPROM or EEPROM prior to the product leaving the manufacturing facility.

GPRS
GPRS stands for General Packet Radio Service. GPRS is a high-speed data transfer 
technique, used on GSM networks.   It does not require a continuous data stream be opened 
between the data source and destination. Instead, it uses packets to move data back and 
forth, making efficient use of the available radio spectrum.

GSM
GSM stands for Global System for Mobiles. It is an open, non-proprietary system with 
international roaming capability providing seamless and standardized same number contact 
ability in more than 170 countries. GSM satellite roaming has extended service access to 
areas where terrestrial coverage is not available.
GSM uses digital technology and time division multiple access transmission methods. Voice 
is digitally encoded via a unique encoder, which emulates the characteristics of human 
speech. This method of transmission permits a very efficient data rate/information content 
ratio.

IMEI
IMEI stands for International Mobile Station Equipment Identity.

Internet Protocol (IP)
Internet Protocol works in conjunction with Transmission Control Protocol (TCP). TCP/IP are 
part of a group of protocols that provide communication across interconnected networks. 
TCP/IP is the protocol used on the Internet. The TCP protocol first establishes a connection 
between two systems to send and receive data, and then breaks and sequentially marks the 
message into small packets. The IP protocol routes and sends the packets based on the IP 
address.

IP Addresses
As with personal computers that access the Internet, modems using GPRS technology also 
use Internet Protocol (IP) address, which are used to identify the node or access point for the 
modem on the Internet. The service provider assigns this IP address. 
The 32-bit host address is usually represented in dotted decimal notation, e.g. 128.121.4.5. 
The address can be split into a network number (or network address) and a host number 
unique to each host on the network and sometimes also a subnet address.

IP Network
A network of computers that use Internet Protocol allowing a user to access the Internet, 
provided that the user has a modem; telephone line, cable line, or wireless data network (e.g. 
GPRS); and a service provider.

Local Area Network (LAN)
A computer network that spans a relatively small area (typically up to a 1 km radius), although 
most LANS are confined to a single building or group of buildings. This type of networking 
allows for easy interconnection of terminals, printers, and computers within a building or 
buildings.
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Network Connection Profiles
A network connection profile is a group of connection settings that define a specific network 
connection to the Modem Manager. This includes such settings as network ID, network 
password, APN, and DNS addresses.

Packet
A short block of data transmitted across a network.

Packet Size
The size of a packet expressed in bytes.

PC Card
A PC Card is a module similar in size to a credit card and compatible with  PCMCIA PC Card 
standards. A PC Card can be used to add optional hardware to portable computing devices. 
Some examples of such options are adding modems, network cards, disk drive adapters, and 
extra memory to devices such as PDAs.

PC Card Slots
The PC Card slots are the sockets in the computing device in which the PC Card is inserted. 
It is the hardware interface between the computing device and the PC Card.

Point-to-Point Protocol (PPP)
PPP is an interconnection protocol which allows a device, such as a wireless IP modem, to 
connect to a network or the Internet.

Primary Domain Name System
To retrieve the translated IP addresses, the modem will try to connect to the server with the 
primary DNS address. If the modem cannot connect to this address, it will try to connect using 
the secondary DNS address.

Registration
To send and receive data across a given network, a GPRS modem must first register on a 
GSM/GPRS network. This involves the selection of an available channel and interaction with 
various systems on the GPRS network to set up a communication path.

Secondary Domain Name System
To retrieve the translated IP addresses, the modem will try to connect to the server with the 
secondary DNS address in instances where it cannot connect to the primary DNS address.

Segment
Each IP network address consists of four numeric segments, which are divided by a period 
("."). For example, 204.119.63.40.

Service Provider
A company that provides network connections to the Internet.

SIM
The term SIM stands for Subscriber Identity Module.
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SIM Card
A SIM card is a type of smart card that contains all of your account information for your GSM and 
GPRS account. It contains keys to encrypt the data and voice information sent across the network 
during a session.

SIM Card Contact Points
These are the small gold- or aluminum-coloured contacts, visible on one side of the SIM card.

Type I PC Card
A PC card with thickness of 3.3 mm. See PC Card.

Type II PC Card
A Type II PC Card is identical to the Type I PC Card in all ways except that it is thicker (5.0 
mm) than the Type I card (3.3 mm). The Type II PC Card is in general use.

Wireless IP Network
A wireless network (e.g. GPRS) that uses Internet Protocol (IP).
Manual Revision 1.0  P/N 


	Table of Contents
	Table of Contents 1
	Getting Started 1
	Installing the Modem Software 5
	Using Connection Profiles 25
	Using the Modem Manager 33
	Modem Manager Reference 53
	Technical Support 63
	Glossary 65

	Getting Started
	Merlin for GPRS Modem Components
	The PC Card
	The SIM Card Slot
	The Antenna
	Using the SIM Card
	Inserting the SIM Card
	Removing the SIM Card
	Inserting the Modem into Your Computer
	Removing the Modem from Your Computer


	Installing the Modem Software
	Installing the GPRS Modem Manager Software on Windows 98, 2000, ME, or XP
	Installing the GPRS Modem Manager Software on Windows NT 4.0
	Verifying the PC Card COM port
	Installing the Modem Drivers
	Configuring the Modem’s Properties and Dial-up Networking on Windows NT 4.0
	Installing Modem Manager Software on Windows NT 4.0


	Using Connection Profiles
	Using a Single Pre-Defined Connection Profile
	Using Multiple Pre-Defined Connection Profiles
	Creating a User-defined Connection Profile
	Creating a GPRS Connection Profile
	Creating a GSM Connection Profile

	Using the Modem Manager
	Launching the Modem Manager
	Entering Your Account PIN
	Entering a PUK
	Enabling or Disabling the PIN
	Changing Your PIN
	Connecting to the Network
	Using Multiple Connection Profiles
	Disconnecting from the Network
	Quitting the Modem Manager
	Creating a New Connection Profile
	Editing a Connection Profile
	Deleting a Connection Profile
	Setting a Connection Profile as Default
	Viewing a Connection Profile’s Properties
	Using the Automatic Network Search Feature
	Using the Manual Network Search Feature
	Viewing the Network Connection History
	Keeping the Modem Manager Always Visible
	Hiding the Modem Manager Window
	Collapsing or Expanding the Modem Manager
	Viewing New Text (SMS) Messages
	Accessing the Modem Manager Online Help
	Accessing Novatel Wireless Web Support

	Modem Manager Reference
	Modem Manager Main Window
	System Tray Icons
	Connection Manager Window
	Detailed Status Report Window
	Modem Properties Window
	About GPRS Modem Manager Window
	GPRS Connection Profile Properties Window
	GSM Connection Profile Properties Window
	The Options Window
	The Add Connection Wizard

	Technical Support
	Technical Support
	Safety and Regulatory Notices
	REGULATORY NOTICES
	General



	Glossary

